
Misure  congiunte del  flusso  dei  muoni e della  pressione
atmosferica.

Le misure che descriviamo in questa sezione e che rendiamo disponibili per l’analisi dati,  fanno
parte delle attività da svolgere durante gli stage estivi per studenti a LNL. 
Gli stage estivi a LNL sono rivolti agli studenti delle 4° classi degli Istituti Superiori italiani, durano
due settimane e sono  organizzati nella seconda metà di giugno  dall’Istituto Nazionale di Fisica
Nucleare  –  Laboratori  Nazionali  di  Legnato  (https://www.lnl.infn.it/eventi-locali-di-3m-stage-
seminari/#1).

Durante le due settimane di stage a LNL gli studenti entrano in contatto con l’attività di ricerca in
fisica  e,  in alcuni  dei percorsi  disponibili,  portano a termine un esperimento  scientifico;  uno di
questi riguarda i  raggi cosmici  e utilizza i dati  acquisiti da un telescopio per muoni. Con queste
misure  sono possibili  varie  osservazioni,  e  tra  queste  anche il  confronto  dei  risultati  di  queste
acquisizioni con gli effetti di disturbo di una variabile ambientale come la pressione atmosferica.

Cosa si vuole  misurare?
Si vogliono dunque misurare due grandezze: da una parte il flusso di raggi cosmici al suolo, più
precisamente di particelle secondarie, i muoni, prodotte dai raggi cosmici primari (prevalentemente
protoni), e dall’altra parte una variabile ambientale come la pressione atmosferica.
Lo  scopo  di  queste  misure  e  del  loro  confronto  è  valutare  l’influenza  media  della  pressione
atmosferica sul valore medio del flusso di muoni a livello del mare.

La dinamica di produzione dei muoni, a partire dai raggi cosmici, è spiegata in dettaglio nei due
percorsi   “Particelle dallo spazio” (https://web.infn.it/OCRA/particelle-dallo-spazio) e “I Muoni”
(https://web.infn.it/OCRA/i-muoni).
Come spiegato nei percorsi sopra indicati, tra le particelle che arrivano a livello del mare i muoni
(μ)  sono  quelle più  numerose  e  più  facilmente  misurabili:  essi  possono interagire  con  alcuni
materiali (gli scintillatori plastici), che emettono luce quando sono attraversati dalla loro traiettoria.

Muoni
Ricordiamone brevemente le caratteristiche principali  dei muoni o particelle μ :

1. sono simili agli elettroni, ma hanno una massa 200 volte maggiore;
2. sono  prodotti  dai  raggi  cosmici  primari,  prevalentemente  protoni,  a  circa  15  km  dalla

superficie terrestre;
3. a terra, attraversano inalterati materiali poco densi (ad es. gli edifici), con piccola perdita di

energia;
4. ogni minuto arrivano al suolo decine di muoni al secondo per cm2;
5. sebbene abbiano una vita media di 2.2 milionesimi di secondo, arrivano fino a  livello del

mare e si fermano sottoterra solo dopo aver attraversato decine di metri di strati di roccia.

Il dispositivo di misura
Il dispositivo di misura utilizzato in questa esperienza è un telescopio con 2 piastre di scintillatori
plastici presente a LNL ed illustrato in Figura 1.
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In sintesi, il dispositivo di misura comprende 2
piani di rivelazione orizzontali e paralleli.
Ciascun  piano  è  costituto  da  una  lastra  di
materiale “sensibile” al passaggio dei muoni o
particelle μ.
Quando  una  particella  μ  attraversa  uno
scintillatore,  essa rilascia  una  piccola  parte
della sua energia nel materiale sotto forma di
luce. La luce prodotta dal passaggio del muone
(i fotoni) viene raccolta da una fibra ottica che
è  inserita  nella  lastra.  Questa  fibra  ottica  ha
anche  il  compito  di  “translare”  la  lunghezza
d’onda  della  luce  emessa  dal  materiale
scintillatore  nella  banda della  luce verde,  una
banda  ottica  dove  sono  attivi  dei  dispositivi
elettronici  particolari,  i  fotomoltiplicatori  a
stato solido o SIPM, che trasformano i lampi di
luce in impulsi di corrente elettrica. La corrente
elettrica  prodotta  dai  SIPM  viene  quindi
elaborata  da  opportuni  circuiti  elettronici  e
“trasformata”  in  un dato  numerico:  la  misura
del numero di muoni che passano attraverso le
due piastre per unità di tempo. Il dato numerico
prodotto  dalla  scheda elettronica  connessa ai  fotomoltiplicatori  e  quindi  anche  agli  scintillatori
viene  infine  trasmesso  ad  un  piccolo  elaboratore  numerico  RaspberryPI  (un  “single  board
computer”, piccolo ma potente) che memorizza i dati e li rende disponibile in rete, su web, sia in
forma numerica che in forma di grafici nel tempo.
I dati vengono raccolti dalla scheda di acquisizione ogni 1 minuto (60 secondi) e sono i seguenti:

1. data e ora (ore:minuti:secondi) relativi alla misura;
2. 4 conteggi singoli, ovvero il numero di “eventi” rilevati da ciascuno dei 4 fotomoltiplicatori

sulle  2  piastre  del  telescopio;  ci  sono  infatti  2  fotomoltiplicatori  su  ciascuna  delle  due
piastre, uno su ciascuna delle 2 terminazioni delle fibre ottiche che raccolgono i flash di luce
prodotti dal passaggio dei muoni attraverso lo scintillatore;

3. 1  conteggio  di  coincidenze,  ovvero  la  numerosità  degli  eventi  che  vengono  rivelati
“simultaneamente” sulle due piastre di scintillatori;

4. il valore di pressione atmosferica misurato dal sensore barometrico presente sulla scheda di
acquisizione dati;

5. il valore di temperatura ambientale rilevato dal sensore di temperatura presente sulla scheda
di acquisizione dati.

Figura 1 - Il telescopio per muoni a LNL con le piastre
in posizione orizzontale



Per l’esame dei dati registrati dal RaspberryPI si devono tener presenti i seguenti fatti:

1. idealmente i conteggi singoli del punto 2 nella lista precedente dovrebbero fornire il numero
di muoni che “passano” per ciascuna delle due piastre ogni minuto, ma in realtà non è così: i
dati dei conteggi singoli sono affetti da un notevole livello di disturbo, che rende difficile il
loro uso diretto: su questi dati è molto agevole, ad esempio, vedere l’effetto assai marcato
delle variazioni di temperatura ambientale;

2. il  conteggio  delle  coincidenze,  ovvero  la  numerosità  degli  eventi  che  vengono  rivelati
“simultaneamente” sulle due piastre di scintillatori è invece un dato molto più indicativo sul
reale flusso di particelle per unità di tempo: vengono infatti conteggiati come “eventi” solo
gli impulsi elettrici che si verificano in un intervallo di tempo così piccolo da poter essere
considerati come simultanei; in questo modo gli eventi spuri dovuti, ad esempio, al rumore
termico  vengono  eliminati  e  il  dato  è  davvero  indicativo  degli  effettivi  passaggi  delle
particelle μ  nel materiale delle piastre.

3. il valore di pressione atmosferica misurato dal sensore barometrico presente sulla scheda di
acquisizione dati è nel range 950-105 mbar; questa grandezza varia molto lentamente, in
genere resta costante per ore, le variazioni sono apprezzabili solo in una intera giornata o in
più giornate;

4. il valore di temperatura ambientale, che di regola ha un  andamento periodico nell’arco della
giornata,  normalmente  con  una  escursione  molto  modesta;  tuttavia  varia  anche  con  la
stagione, con spostamenti molto lenti del valore medio nelle settimane e nei mesi.

Raccolta dati.

Per avere misure significative dell’influenza della pressione atmosferica sul flusso dei muoni a terra
occorre raccogliere  dati  per almeno 2-3 giorni.  Per fortuna il  modulo RasperryPI collegato alla
scheda  di  acquisizione  dati  lo  fa  da  solo!  Naturalmente  occorre  raccogliere  dati  in  condizioni
“stazionarie”,  cioè  con  una  configurazione  fissa  del  telescopio,  in  termini  di  posizione  e
orientamento, per 2-3 giorni o più. Un’agevole accesso ai dati registrati è possibile solo dalla rete
interna  dei  LNL.  Oppure  (con  un  po’  di  ritardo,  i  dati  sono  disponibili  sul  server  pubblico
http://www2.lnl.infn.it/~canella/COSMIC/WWW2/DatiGiornalieri)

Elaborazione dei dati.

Per questa parte dell’esperienza è conveniente utilizzare i dati memorizzati dal modulo RaspberryPI
e trasferirli  in  un foglio  elettronico  di  calcolo,  per  esempio Excel,  Calc o uno Sheet  di  lavoro
Google.
Un’altra possibilità è quella di usare un programma Python dedicato, che legga i dati ed effettui le
necessarie  elaborazioni;  per quest’ultima opzione occorre avere un po’ di  dimestichezza  con la
programmazione; se ne parlerà separatamente.

Nel file dove i dati vengono registrati si ha, all’incirca, un dato ogni minuto. Tuttavia non conviene
usare i dati così come sono registrati “in modo grezzo”, perché la misura del flusso di muoni è una
grandezza aleatoria con una certa variabilità intrinseca, ben visibile anche dai grafici associati alle
registrazioni, come illustrato nella Figura 2 qui sotto. 
La distribuzione di probabilità che descrive, con buona approssimazione, i fenomeni di conteggio di
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raggi cosmici al suolo è la distribuzione di Poisson. L’errore statistico associato a questo tipo di
distribuzione è √C, dove C è il numero di eventi per ogni misura. Poiché stiamo analizzando il rate
delle particelle, l’errore relativo a questa quantità deriva dalla propagazione degli errori e si ottiene
dividendo l’errore del numero di conteggi (√C) per il tempo T.

Figura 2 – Due grafici con l’andamento dei conteggi singoli (rosso, blu, arancio, verde) e delle coincidenze (grigio) in
due diverse giornate: a sinistra una giornata convenzionale con il telescopio in posizione fissa, a destra una giornata
in cui le due piastre sono state fatte ruotare per cambiare l’angolo azimutale con una variazione angolare di 10° ogni
ora,  a partire dalle ore 10:30 circa, e con un angolo iniziale di 90°.

E dunque, come stimare la misura? La migliore stima del valore vero è la media aritmetica di un
certo numero di valori ottenuti nelle varie misure. Operativamente la cosa migliore è fissare degli
intervalli di tempo ragionevoli, come minimo di 1 ora, ma anche 2 o 4 o 6 ore o perfino le 24 ore di
un’intera giornata e calcolare il valore medio di tutte le misure di flusso che cadono all’interno
dell’intervallo di tempo fissato. Con questa operazione il valore medio del flusso di muoni diventa
molto più “stabile” (la variabilità delle medie è molto più bassa dei valori presi in un minuto).
Per  fare  un  ragionevole  confronto,  la  stessa  operazione  deve  essere  eseguita  anche  sui  valori
registrati di pressione atmosferica utilizzando gli stessi intervalli di tempo fissati per il flusso di
muoni. Questo va fatto anche se la variabilità della pressione atmosferica è estremamente più bassa:
a volte il suo valore resta costante per diverse ore.

Al termine di questa operazione si ottiene una tabella con un numero ridotto di dati, su 3 colonne:
una colonna per il tempo (ad esempio, scegliendo di eseguire le medie sule 24 ore di una intera
giornata, nella prima colonna si avrà il numero del giorno), una seconda colonna per il valore medio
del flusso di muoni nel periodo e una terza colonna per il valore medio della pressione atmosferica
nel periodo.

Qui di seguito un esempio di tale tabella relativamente al mese di dicembre 2021, con il telescopio
posizionato stabilmente nella sala Centrino di LNL e con le piastre in posizione orizzontale. Per tali
misure la registrazione della pressione atmosferica locale non era ancora disponibile e sono stati
usati i dati “on-line” registrati da ARPAV nella stazione meteorologica di Porto Tolle (RO), che
non dista che qualche decina di km da LNL.



data coincidenze P. atm.
2021-12-01 88.45 1016.1
2021-12-02 90.98 1004.09
2021-12-03 88.87 1015.61
2021-12-04 89.05 1015.08
2021-12-05 90.04 1006.69
2021-12-06 89.65 1013.44
2021-12-07 89.00 1017.67
2021-12-08 89.95 1008.52
2021-12-09 91.08 1004.13
2021-12-10 91.20 1007.04
2021-12-11 89.45 1012.75
2021-12-12 86.77 1027.78
2021-12-13 86.53 1031.80
2021-12-14 86.59 1033.37
2021-12-15 85.91 1036.59
2021-12-16 85.02 1038.69
2021-12-17 85.26 1038.70
2021-12-18 84.97 1039.93
2021-12-19 86.72 1030.76
2021-12-20 87.56 1024.10
2021-12-21 87.37 1030.43
2021-12-22 86.66 1032.43
2021-12-23 86.68 1029.61
2021-12-24 87.84 1020.98
2021-12-25 88.97 1013.96
2021-12-26 89.36 1013.08
2021-12-27 89.30 1014.17
2021-12-28 88.72 1013.45
2021-12-29 87.61 1015.27
2021-12-30 86.14 1026.77
2021-12-31 85.44 1032.18

Figura 3 –  Tabella con i dati relativi ai valori medi giornalieri del flusso di muoni (coincidenze) e della pressione
atmosferica, per il mese di Dicembre 2021

A questo punto, a partire dai dati della tabella è possibile produrre uno “scatter plot”, ovvero un
grafico in cui sono evidenziate le posizioni delle coppie (pressione-atmosferica, flusso-medio) su un
piano cartesiano:



La linea scura è la retta di regressione che meglio approssima il legame lineare tra le due variabili.

Sempre con i dati della tabella, sul foglio di calcolo, è possibile calcolare la correlazione numerica
tra le due colonne di dati, pressione atmosferica e flusso medio di muoni:

correlazione= -0.965

Tale dato di correlazione ha valore assoluto molto vicino a 1; questo è indicativo di un forte legame
di dipendenza tra le due grandezze, ovvero che la misura del flusso medio di muoni dipende dal
valore medio della pressione atmosferica.

Confronto diretto  dell’andamento temporale  dei  dati  di  pressione atmosferica  e  di  valore
medio di flusso di muoni

Un altro modo per visualizzare in chiaro il legame tra pressione atmosferica e valore medio del
flusso di muoni al suolo è quello di mettere in un grafico i dati della tabella con l’avvertenza di
“ribaltare” simmetricamente l’andamento della pressione atmosferica rispetto ad un valore costante
di riferimento. Usando, ad esempio un valore di riferimento di 1000 mbar, la formula per ottenere i
valori di pressione “ribaltati” rispetto al valore di riferimento è:

Pr = 1000 - (1000 – P) = 2000 -P

Il grafico che si ottiene:

Figura 4 – "Scatter plot" per flusso di muoni medio e pressione atmosferica media al suolo 
nel mese di Dicembre 2021
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La stretta relazione fra l’andamento della curva blu, le coincidenze medie nella singola giornata,
ovvero il flusso medio sulle 24 ore, e la curva rossa, l’andamento medio della pressione atmosferica
“ribaltata” rispetto al valore di riferimento di 1000 mbar, è molto evidente su tutto il mese.
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Figura 5 –  Andamento nel tempo del flusso medio dei muoni (blu) e della pressione atmosferica (rorro a tratti) nel mese di 
Dicembre 2021. La linea rossa continua è relativa alla pressione atmosferica specularmente rovesciata rispetto alla linea 
1000 mbar
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APPENDICE 1: analisi dei dati da foglio elettronico

In primo luogo consideriamo il formato dei dati relativi ai muoni registrati nei file giornalieri. 
I file di registrazione sono file testuali, con tutti i dati “scritti in chiaro” e visualizzabili anche con
un editor di testo. 
Anche il nome del file contiene informazione: il nome dei file ha sempre il formato “YYYY-MM-
DD” ovvero ANNO (YYYY, su 4 cifre), poi MESE (MM, su 2 cifre) e infine GIORNO (DD, su 2
cifre). Ad esempio il file 2022-03-08.dat contiene i dati registrati il giorno 8 marzo 2022.
All’interno di ciascun file i dati sono organizzati su 9 colonne (qui sotto indicate da C1 a C9):

C1         C2      C3         C4         C5         C6             C7 C8   C9
08:00:13   479     148768     167784     188705     252121         43 1026 18.2 
08:01:13   480     149039     168163     189349     252275         37 1026 18.3 
08:02:13   481     149862     168292     190613     251192         45 1026 18.3 
08:03:13   482     148640     167890     190198     251136         33 1026 18.2 
08:04:13   483     147894     167737     190189     250979         35 1026 18.3 
08:05:13   484     148024     167428     190580     250340         37 1026 18.4 
08:06:13   485     148921     167873     190719     250539         39 1026 18.3 
08:07:13   486     148247     167079     190584     250435         37 1026 18.4 
08:08:13   487     148178     168572     192219     251080         34 1026 18.5 
08:09:13   488     148080     167214     191510     250821         32 1026 18.5 
08:10:13   489     149122     167345     192016     250579         39 1026 18.7 
08:11:13   490     149319     168262     190794     250443         45 1026 18.7 
08:12:13   491     149538     168235     191089     252447         43 1026 18.8 
08:13:13   492     148383     168324     191620     252104         38 1026 18.8 
08:14:13   493     149647     168344     191452     253034         34 1026 19.0 
08:15:13   494     149656     168680     190759     253246         42 1026 19.0 

Qui di seguito viene specificato il significato di ciascuna colonna:

C1 = ore(hh):minuti(mm):secondi(ss), il tempo della misura, ora locale nel formato hh:mm:ss
C2 = contatore interno, fornisce un contatore a partire dalla prima registrazione della giornata
C3 = conteggio singolo da SIPM1
C4 = conteggio singolo da SIPM2
C5 = conteggio singolo da SIPM3
C6 = conteggio singolo da SIPM4
C7 = coincidenze, ovvero conteggi di eventi “simultanei” dai 4 SIPM
C8 = pressione atmosferica (in mbar)
C9 = temperatura ambiente (in °C)

I dati principali per le elaborazioni statistiche qui considerate sono quelle delle colonne C1 (tempo),
C7 (coincidenze) e C8 (pressione atmosferica).

I  dati  delle  altre  colonne servono a  tenere  sotto  controllo  il  buon funzionamento  dell’apparato
(colonne C2, C3, C4, C5 e C6) e le condizioni  ambientali  (colonna C9, la temperatura,  che ha
grande influenza sui dati C3, C4, C5, C6)



Inserimento dei dati un uno “Foglio di Calcolo” o SpreadSheet

Vediamo ora come caricare i dati di un file di questo tipo nella scheda di un foglio elettronico.
Il  primo  esempio  viene  fatto  usando  “CALC”  il  foglio  elettronico  open-source  del  pacchetto
LibreOffice, una variante “libera” di Microsoft Office Excel

Si apre un nuovo file con l’applicazione Calc, si ha una scheda vuota (sheet1) senza alcun dato:

si procede a caricare i dati che interessano, quelli contenuti in 2022-03-08.dat, con 
Sheet → Insert Sheet from file

a questo punto compare il browser dei file con cui è agevole scegliere il file di dati che interessa:



si attiva il pulsante “Open” e compare una finestra di aiuto al caricamento dei dati, relativamente al
formato, che può essere personalizzato; in genere, la formattazione normale va bene:

E’  importante che il  separatore sia lo spazio (Space),  è  bene utilizzare l’opzione  Merge per
evitare la creazione di inutili colonne vuote. Inoltre è utile , ma non necessario, evitare di caricare le
colonne 3,4,5 e 6 selezionandole sull’area di definizione (Standard) con il tasto shift premuto per la
selezione multipla  e l’opzione “hide”. Con OK si attiva il caricamento dei dati,  dopo aver dato
conferma in un’ultima finestra:



ove viene specificato il nome della scheda (o foglio, sheet) e la sua posizione rispetto agli esistenti,
in questo caso “in coda” a a quello attualmente in uso; con OK i dati vengono caricati e si dispone
di una scheda o sheet come qui sotto illustrato:

Si può ora iniziare a lavorare sui dati, per produrre i valori statistici che li caratterizzano  e i grafici
che ne illustrano l’andamento nel tempo e l’uno in funzione dell’altro.



Dati Statistici

Ci proponiamo di fare ora una semplice analisi statistica dei dati di cui disponiamo; programmando
ad esempio, il  calcolo di media, scarto quadratico medio (standard deviation),  valori massimo e
minimo dei dati su ciascuna colonna. Come fare: si usano le funzioni già predisposte a questo scopo
nel  foglio  elettronico.  Prendiamo ad esempio  la  colonna  delle  coincidenze  (la  colonna C della
scheda 2022-03-08). Si inserisce una riga vuota prima dei dati: si seleziona la prima riga (con un
click su 1, come indice di riga, poi, con il cursore sopra l’indice di riga 1, con il tasto destro del
mouse si sceglie “Insert row above” e si crea una riga vuota sopra i dati.

Ora nella cella C1, vuota, si inserisce la funzione media (average) con il function wizard;

L’attivazione del tasto fx provoca la comparsa di una finestra di supporto alla programmazione della
funzione:



Dalla finestra del function wizard si seleziona la funzione average, poi Next, che attiva una seconda
finestra, in cui specificare i dati sui quali calcolare la media:

In  questo  caso,  volendo  calcolare  la  media  (AVERAGE)  sui  circa  1440  dati  giornalieri  di
coincidenze al minuto si deve selezionare il range C2:C1439 nel campo dell’argomento di fx, poi
dare OK. Ora, nella cella C1 compare il valore medio di tutti i dati giornalieri di coincidenza relativi
alla giornata 2022-03-08.
In modo del tutto analogo, per lo stesso set di campioni, si possono calcolare il minimo (MIN), il
valore massimo (MAX) e lo scarto quadratico medio (STDEV). 
Le stesse funzioni statistiche possono essere poi predisposte per i valori di pressione atmosferica
(colonna D) e per la temperatura (colonna E).
Attenzione agli indici di riga, nel predisporre le funzioni dopo aver inserito nuove righe!





Grafici

Ci proponiamo ora di vedere come fare dei grafici, ad esempio per controllare l’andamento delle
coincidenze durante la giornata.

Con Calc di LibreOffice si può fare in modo guidato, usando lo strumento Insert→Chart:

e poi selezionando in modo guidato il tipo di grafico e i dati da usare nel grafico:



ottenendo in questo modo il  grafico con l’andamento  dei valori  di  coincidenza  in funzione del
contatore in colonna B:

L’esempio di grafico qui usato è del tipo XY,  che è il tipo da usare per lo “scatter plot” di Fig. 4,
nel momento in cui sono stati calcolati un certo numeri di valori medi relativamente a coincidenze e
pressione atmosferica, ad esempio su varie giornate di acquisizione, o almeno su periodi da alcune
ore al giorno in ciascuna giornata.
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APPENDICE 2: analisi dei dati usando Google Sheet

Il  formato  dei  dati  relativi  ai  muoni  registrati  nei  file  giornalieri  rimane  quello  illustrato  in
Appendice 1, a cui si rimanda per i dettagli.

Vediamo ora  come caricare  i  dati  di  un  file  di  questo  tipo  nella  scheda del  foglio  elettronico
accessibile  come strumento nell’area  di  lavoro Google,  associata  all’area  dati  Drive,  sempre di
Google.

Si apre un nuovo file Sheet

e si ha una scheda vuota (Sheet1) senza alcun dato:

per procedere a caricare i dati che interessano, quelli contenuti in 2022-03-08.dat, occorre che il file



abbia l’estensione txt (anziché dat), si deve pertanto cambiare opportunamente il nome del file e
caricarlo nel Google Drive (upload) poi si può passare all’operazione di “lettura” dei dati usando lo
strumento File → Import e selezionando il file di interesse con il browser

e selezionando il file di interesse con il browser:

si attiva il pulsante “Select” e compare una finestra di richiesta di conferma (“Import data”) con
opzioni di default che, di norma, sono appropriate:



L’importazione dei dati avviene correttamente, vengono caricate anche le colonne con gli eventi
“singoli”  (colonne  C,  D,  E,  F)  che  possono  venire  “nascoste”  o  cancellate,  essendo  di  scarso
interesse nello studio congiunto degli effetti della pressione atmosferica sul flusso di muoni.

Si dispone ora di una scheda con la quale si può ora iniziare a lavorare sui dati, per produrre i valori
statistici che li caratterizzano  e i grafici che ne illustrano l’andamento nel tempo e l’uno in funzione
dell’altro.



Dati Statistici, con Google sheet

Ci proponiamo di fare ora una semplice analisi statistica dei dati di cui disponiamo; programmando
ad esempio, il  calcolo di media, scarto quadratico medio (standard deviation),  valori massimo e
minimo dei dati  su ciascuna colonna. Come fare:  anche in questo caso si usano le funzioni già
predisposte  a  questo  scopo  nel  foglio  elettronico.  Prendiamo  ad  esempio  la  colonna  delle
coincidenze (la colonna C della scheda 2022-03-08). Si inserisce una riga vuota prima dei dati: si
seleziona la prima riga (con un click su 1, come indice di riga, poi, con il cursore sopra l’indice di
riga 1, con il tasto destro del mouse si sceglie “Insert 1 row above” e si crea una riga vuota sopra i
dati.

Ora nella cella G1, vuota, si inserisce la funzione media (average) con
 Insert → Function → AVERAGE



Ora non resta che selezionare i dati su cui calcolare la media: il range G2:G1440

In  modo  del  tutto  analogo  possono  essere  inserite  ulteriori  righe  per  i  valori  minimo  (MIN),
massimo (MAX) e di scarto quadratico medio (STDEV), anche qui facendo attenzione agli indici di
riga dei valori da usare nel calcolo delle funzioni.



Grafici con Sheet di Google

Ci proponiamo ora di vedere come fare dei grafici,  di  nuovo per controllare  l’andamento delle
coincidenze durante la giornata.

Con Sheet di Google si può fare in modo guidato, usando lo strumento Insert→Chart:

e poi selezionando in modo guidato il tipo di grafico e i dati da usare nel grafico:



ottenendo in questo modo il  grafico con l’andamento  dei valori  di  coincidenza  in funzione del
tempo in colonna A:

L’esempio di grafico qui usato è del tipo XY,  che è il tipo da usare per lo “scatter plot” di Fig. 4,
nel momento in cui sono calcolati un certo numeri di valori medi relativamente a coincidenze e
pressione atmosferica, ad esempio su varie giornate di acquisizione, o almeno su periodi da alcune
ore al giorno in ciascuna giornata.


